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Specifications for a GUI for BasisPlus Databases

Introduction

Gill is defined as 'Graphic User Interface' across all computer platforms. In the Microsoft
Windows environment, for example, along with icons and buttons, the Gill usually displays
various options grouped under pull down menu labels. These labels include 'File', 'Edit', 'Format',
'Window', and others specific to that application. In other words the menus provide an almost
unlimited number of options for the user to choose from.

It is the philosophy of CDIE, however, that these options are acceptable for the frequent or
sophisticated Windows user but leave the occasional or more intimidated user wondering where
to start, especially with the more complicated applications such as databases and concepts such as
Boolean operators.

Therefore, CDIE, in the case of the development of a general agency interface to BasisPlus,
defines Gill as Guided Gill, or the 'Guided Graphic User Interface'. This interface, while using
the options generally agreed to compose a GUI, draws on the logic of the 'Guided Mode' interface
used in the CD-ROM entitled CD-DIS. Through a series of simple and straightforward choices,
the user is 'guided' through an online search, insuring that the information retrieval process does
not become derailed and the user frustrated.

References

To fully implement the Guided Gill in accordance with the established CD-DIS 'guided mode' and
general Gill guidelines, the following references should be reviewed before and during the design
process:

CD-DIS: A.I.D. 's Development Information System on CD-ROM
(disc and manual, available from CDIE)

CD-ROM Consistent Interface GUidelines, SIGCAT, 1991
(available from CDIE)

Guidelinesfor Enterprise-wide GUI Design, Susan Weinschenk and Sarah C. Yeo,
John Wiley & Sons, 1995

The Windows Interface: An Application Design Guide, Microsoft Press, 1992
(book and 2 disks)

Common User Interface Standard, IRM/USAID, draft of April 14, 1993
(available from CDIE)



Overall Specifications

The CD-DIS Guided Mode interface was based on the CD-ROM Consistent Interface Guidelines,
developed in 1991 by SIGCAT, the Special Interest Group on CD-ROM Applications and
Technology. Although developed for a CD-ROM applications, the general functions can be
applied to online data retrieval as well. The guidelines identify and name thirteen (13) basic user
functions no matter whether the user interface is menu driven, graphical, or keyboard input based.
The functions are grouped into three areas: top level, operational, and navigational.

Top Level Help, Browse Index, Search, Display
Print, Download, Restart

Operational Execute, Break, Escape

Navigation Move down display, line by line
Move up display, line by line
Move down one screen or window
Move up one screen or window
Move to the next item or record
Move to the previous item or record
Move to the next hit (occurrence of search term or match)
Move to the previous hit
Move to a specified location
Move across display horizontally, as from menu to menu or field to field

The above functions, with the exception of the 'move to next hit', have been implemented in
CD-DIS. This function, however, must be implemented in the Guided Gill for BasisPlus.

The Guided Graphic User Interface

The Guided GUI mode guides the user through the search process, step-by-step, via a series of
menus and screens. Only the options which are logical at each step are present on the screen, and
only the screen pertinent at that point in the search process is displayed. The following discussion
relates to the interface developed for CD-DIS (whose functionality is to be replicated) and the
primary DIS databases (Documents and Projects) which are to be made available as a result of
this effort.

General Functions

Nine functions must be available at all times throughout the interface:

(1) movement up and down a menu or display screen by using vertical scroll bars or the up
and down arrow keys;



(2) make a selection by using an 'OK' button or the ENTER key;

(3) back out of an option or step by using the 'CANCEL' button or 'ESC' key. Other
functions are displayed within a box only when necessary (for example, 'PRINT... ' , when
a record is displayed within a screen);

(4) change database by choosing 'DATABASE' menu bar entry; a submenu will include the
choices 'DOCUMENTS' and 'PROJECTS', which may be renamed or have additional
choices added in the future;

(5) restart the search process within the same database by choosing the 'RESTART' menu bar
entry (and thereby discarding the current search) and responding to question in a dialog
box 'This will discard your current search. Do you wish to continue?' and display the
appropriate 'OK' and 'CANCEL' buttons;

(6) terms searched must be highlighted in some manner when a record or text is displayed on
the screen;

(7) 'Print Setup' made available through the 'File' menu bar entry only and not through the
individual print dialog boxes;

(8) 'Copy' and 'Paste' available through the 'Edit' menu bar entry'

(9) 'Exit', to exit the interface, available through the 'File' menu bar entry and occur only if an
affirmative answer is received to the question in a dialog box 'This will discard your
current search. Do you wish to continue?' and display the appropriate 'OK' and 'CANCEL'
buttons.

Menu Bar and Pull-Down Menus

Menu bar entries consist of one word and are available only when that option is appropriate for
the screen displayed. Pull-down menu entries are descriptive. For example, not 'Print', but 'Print
Record', or 'Print All Found' -- the entry contains not only the verb but the noun as well.

Help Function

Context sensitive online HELP must be available in any window by pressing the 'HELP' button or
choosing HELP from the menu bar. When HELP is chosen from the menu bar, the first entry
must be specific to the screen from which HELP was invoked; successive entries are for the
complete HELP function which covers the entire Guided GUI and follows the standard method
for a windowed interface.



Starting the Guided GUI

The user is presented with two database selections (DOCUMENTS, and PROJECTS) which
include short descriptive text relating to each selection. In addition, more detailed information
must be available through the HELP function outlined previously.

As the number of database selections may increase or be renamed in the future, the method of
listing must be flexible so as to accommodate possible changes.

The Basic Search Cycle (BSC)

The BSC displays information in succession on the screen in clockwise fashion. This begins in the
upper left with the options to search (i.e., 'Search by... '); continue with the available search terms
to the right, which is overlaid by a display of the search results. The final part of the cycle appears
in the lower left, which permits the user to choose to 'Display Results', 'Refine Search', or 'Print
Results'.

At each step, the border of the active area is highlighted to identify to the user where the next
choice is to be made. The user may not Jump back' either through the use of keyboard entries or
the mouse to the search options portion unless the user chooses RESTART or DATABASE from
the menu bar.

Options To Search

When the user chooses one of the 'Search by... ' options, they are presented with three types of
information:

(1) available search terms (for example, subject terms) with the following characteristics: (a)
can scroll the list, (b) can jump to a particular term by typing all or part in a data input
area labeled 'Type <term>:', (c) can choose as many as needed and indicate in some
manner that they have been chosen; and (d) the list of available terms may, if necessary,
take up the screen and thereby cover the 'Search by... ' menu or list;

(2) a data entry box for free-form entry of search terms (for example, title words) which must
also permit the use of a 'wild card' character (e.g.: agricultur*) to facilitate the search;

(3) submenu of choices (for example, 'Report Type' which presents the user with the options
'General Category' and 'Specific Type').

Refining The Search

If the user chooses the 'Refine Search' option, the user is offered four courses of action:



(1) 'Narrow Search' (equivalent to the Boolean 'AND')

(2) 'Broaden Search' (equivalent to the Boolean 'OR')

(3) 'Exclude Terms' (equivalent to the Boolean 'NOT')

(4) 'Undo Last Step', which discards the last search result.

The user then proceeds through another search cycle by choosing the same or other 'Search by... '
option. Upon completion of this cycle, the user again has the option to 'Display Results', 'Refine
Search', or 'Print Results'.

Record Display

When the user chooses the 'Display Results' option, the records found are displayed. The display
must have the following characteristics:

(1) the record box takes the entire width of the screen, therefore blocking the view of all other
search screens;

(2) contrary to standard Gill guidelines (Weinschenk, p. 36), field labels are right justified;

(3) data displayed is formatted as follows: (a) one blank space between label colon and data
start, (b) second and all subsequent lines of any field is indented and starts one space to
the right of the first character in the first data line, (c) multiple occurrences of a field,
except institution names are displayed in succession on the same line and indented as
noted above, (d) each institution name starts on a new indented line and all align under the
first occurrence, with long name continuation lines indented as noted above;

(4) a 'counter' to show the number of the current record within the set found (e.g.: '27 of35');

(5) the options 'Next Record' and 'Previous Record' must be available in some manner, such as
buttons, and be available through the use of the '+' and '-' keys;

(6) the option 'Select For Print' must be available and, when chosen, display in some manner,
such as a check box, that the record has been selected for printing; the user must also have
the option to reverse this decision;

(7) the option 'PRINT... ' must be available and follow specifications noted in 'Print Options',
(following) second paragraph.



(8) the option 'Go To... ' must be available, where choosing this option will display a dialog
box with the text 'Go to record <n>' to permit the user to enter a specific record number
for display.

[see CD-DIS user manual, pp. 18-26, for additional information]

Print Options

When the user choses the 'Print Results' option in the basic search cycle (without first viewing the
records), the user must respond to a question in a dialog box: 'This will print the entire results.
Do you wish to continue?' and display the appropriate 'OK' and 'CANCEL' buttons. Pressing the
'OK' button continues to the next set of options noted below.

While at the record display level, if the user chooses 'PRINT... ', then the user is given the option
to change the format of the record(s) with the question 'Which format would you like?' and is
presented with these choices:

(1) in DOCUMENTS: (a) 'Title List', which includes data from title and date fields, (b) 'Full
Citation', which includes all the fields except the abstract, (c) 'Full Citation With Abstract';

(2) in PROJECTS: (a) 'Full Citation', which includes all the fields except the abstract, (b) 'Full
Citation With Abstract'.

After a format is chosen two additional options are displayed:

(1) 'Print';

(2) 'Download' with the question 'Where do you want the output to go?'.

If 'Print' is chosen, the output is printed to the available printer, whether local or network.

If 'Download' is chosen, the user is directed to 'Please enter a path and filename, including drive
letter designation'. A sample path and filename is included in the display.

IMPORTANT NOTE: The remainder of this attachment identifies the search fields which must
be present in the individual databases. There are two ways to enter search criteria: (a) select an
index term from a list of available terms, and (b) enter free form search terms. Where
appropriate, the following statements apply and must be provided as part of the interface.

(1) When selecting items from an index list of available items the user must be able to move
within the display in two ways: (a) scroll the list; or (b) jump to any portion of the list by
typing in all or part of the index term in a data input area labeled 'Type <search field
name>:'.



(2) When selecting items from an index list the user must be able to choose as many items as
needed and items chosen must be indicated in some manner. The list of available items may, if
necessary, take up the width of the screen and thereby cover the 'Search by... ' menu or list.

(3) When selecting items from an index list the interface must search for all items chosen by
using the Boolean 'OR' when the 'SEARCH' button is pressed.

(4) When entering free form search terms a dialog box must appear which permits data input
with the following characteristics: (a) words may be typed in any order, and (b) truncated
searching may be invoked by using the <'?'><'*'> wildcard characters. An example of a
truncated search must be included in the dialog box.

(5) When entering free form search terms the interface must search for all words entered by
using the Boolean 'AND' when the 'SEARCH' button is pressed.

(6) For either method, the use of the 'CANCEL' button or 'ESC' key to back out of an option
must be available.

The DOCUMENTS Database

When the DOCUMENTS database is selected the user is presented with a selection of options to
search by ('Search by... '):

Subject
CountrylRegion
Title Words
Project Number
Year
Abstract Words
Personal Author
Institution
DOCID/Order Number
Report Type

Subject: When the user selects 'Search by... ' 'Subject', a file containing a rotated list of subject
terms is displayed across the width of the screen. A portion of the list might appear as:

HEALTH
HEALTH education
HEALTH indicators

Safety and HEALTH Regulations
Maternal and Child HEALTH

HEALTH statistics



..

County/Region: When the user selects 'Search by... ' 'CountylRegion', three options must be
available: (1) Country Name; (2) Geographic Region; (3) USAID Geographic Bureau, with the
question 'Do you wish to search by... '. Choosing any of the three displays the appropriate list of
geographic names, either from an index or from a file. In addition, when option 2 or 3 is chosen,
specific information on what countries and geographic areas are included in each category must
be available through the HELP function outlined previously.

Title Words: When the user selects 'Search by... ' 'Title Words', a dialog box must appear which
permits free form input ofwords which may have been used in a title.

Project Number: When the user selects 'Search by... ' 'Project Number', an index containing a list
of project numbers must be displayed.

Year: When the user selects 'Search by... ' 'Year', an index containing a list ofyears must be
displayed.

Abstract Words: When the user selects 'Search by... ' 'Abstract Words', a dialog box must appear
which permits free form input ofwords which may have been used in an abstract.

Personal Author: When the user selects 'Search by... ' 'Personal Author', an index containing a
list of author names, last name first, must be displayed.

Institution: When the user selects 'Search by... ' 'Institution', an index containing a list of
institution names must be displayed.

DOCID/Order Number: When the user selects 'Search by... ' 'DOCID/Order Number', an index
containing a list of document numbers must be displayed.

Report Type: When the user selects 'Search by... ' 'Report Type', two options must be presented:
(1) 'General Category' and (2) 'Specific Type', with the question 'Do you wish to search by... '.
Upon making a selection, the appropriate list of document types must be displayed, either from an
index or from a file. In addition, when option 1 is chosen, specific information on what report
types are included in each general category must be available through the HELP function outlined
previously.

The PROJECTS Database

When the PROJECTS database is selected the user must be presented with a selection of options
to search by (Search by... '):

Subject
CountrylRegion
Title Words
Project Number



..

Abstract Words
Beginning Fiscal Year
Ending Fiscal Year
Project Status
Geographic Code

Subject: When the user selects 'Search by... ' 'Subject', a file containing a rotated list of subject
terms must be displayed across the width of the screen. A portion of the list might appear as:

HEALTH
HEALTH education
HEALTH indicators

Safety and HEALTH Regulations
Maternal and Child HEALTH

HEALTH statistics

County/Region: When the user selects 'Search by... ' 'County/Region', three options must
become available: (1) Country Name; (2) Geographic Region; (3) USAID Geographic Bureau,
with the question 'Do you wish to search by... '. Choosing any of the three must display the
appropriate list ofgeographic names, either from an index or from a file. In addition, when either
option 2 or 3 is chosen, specific information on what countries and geographic areas are included
in each category must be available through the HELP function outlined previously.

Title Words: When the user selects 'Search by... ' 'Title Words', a dialog box must appear which
permits free form input of words which may have been used in a title.

Project Number: When the user selects 'Search by... ' 'Project Number', an index containing a list
of project numbers must be displayed.

Abstract Words: When the user selects 'Search by... ' 'Abstract Words', a dialog box must appear
which permits free form input of words which may have been used in an abstract.

Beginning Fiscal Year: When the user selects 'Search by... ' 'Beginning Fiscal Year', a file or
index containing a list of years must be displayed.

Ending Fiscal Year: When the user selects 'Search by... ' 'Ending Fiscal Year', a file or index
containing a list ofyears must be displayed.

Project Status: When the user selects 'Search by... ' 'Project Status', a file or index containing a
list of possible project statuses must be displayed.

Geographic Code: When the user selects 'Search by... ' 'Geographic Code', an index containing a
list of agency geographic codes must be displayed.


